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AXIS COMMUNICATIONS<Product Name> Quick User’s Guide

About this Document
This manual is intended for administrators and users of the 
AXIS 210/211 Network Camera, and is applicable for 
software release 4.20. It includes instructions for using and 
managing the AXIS 210/211 on your network. Previous 
experience of networking will be of use when using this 
product. Some knowledge of UNIX or Linux-based systems 
may also be beneficial, for developing shell scripts and 
applications. Later versions of this document will be posted to 
the Axis Website, as required. See also the product’s online 
help, available via the Web-based interface.

Intellectual Property Rights
Axis AB has intellectual property rights relating to 
technology embodied in the product described in this 
document. In particular, and without limitation, these 
intellectual property rights may include one or more of the 
patents listed at http://www.axis.com/patent.htm and one or 
more additional patents or pending patent applications in the 
US and other countries. 

This product contains licensed third-party software. See the 
menu item “About” in the product’s user interface for more 
information.

This product contains source code copyright Apple Computer, 
Inc., under the terms of Apple Public Source License 2.0 (see 
http://www.opensource.apple.com/apsl/). The source code is 
available from: 
http://developer.apple.com/darwin/projects/rendezvous/

Legal Considerations
Video and audio surveillance can be prohibited by laws that 
vary from country to country. Check the laws in your local 
region before using this product for surveillance purposes.
This product includes one (1) MPEG-4 decoder license. To 
purchase further licenses, contact your reseller.

Electromagnetic Compatibility (EMC)
This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance 
with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that 
interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures: 
Re-orient or relocate the receiving antenna. Increase the 
separation between the equipment and receiver. Connect the 
equipment to an outlet on a different circuit to the receiver. 
Consult your dealer or an experienced radio/TV technician 
for help. Shielded (STP) network cables must be used with 
this unit to ensure compliance with EMC standards. If the I/O 
terminal connector is used, a ferrite core (available e.g. from 
Axis) should be fitted around the wires in order to ensure 
compliance with EMC standards.

USA - This equipment has been tested and found to comply 
with the limits for a Class B computing device pursuant to 
Subpart B of Part 15 of FCC rules, which are designed to 
provide reasonable protection against such interference when 
operated in a commercial environment. Operation of this 
equipment in a residential area is likely to cause interference, 
in which case the user at his/her own expense will be 
required to take whatever measures may be required to 
correct the interference. 

Europe -  This digital equipment fulfills the 
requirements for radiated emission according to limit B of 
EN55022/1998, and the requirements for immunity according 
to EN55024/1998 residential, commercial, and light industry.

Japan - This is a class B product based on the standard of 
Download from Www.Somanuals.co
the Voluntary Control Council for Interference from Information 
Technology Equipment (VCCI). If this is used near a radio or 
television receiver in a domestic environment, it may cause radio 
interference. Install and use the equipment according to the 
instruction manual. 

Australia - This electronic device meets the requirements of the 
Radio communications (Electromagnetic Compatibility) Standard 
1998 AS/NZS 3548. 

Liability
Every care has been taken in the preparation of this manual. 
Please inform your local Axis office of any inaccuracies or 
omissions. Axis Communications AB cannot be held responsible 
for any technical or typographical errors and reserves the right to 
make changes to the product and manuals without prior notice. 
Axis Communications AB makes no warranty of any kind with 
regard to the material contained within this document, including, 
but not limited to, the implied warranties of merchantability and 
fitness for a particular purpose. Axis Communications AB shall 
not be liable nor responsible for incidental or consequential 
damages in connection with the furnishing, performance or use of 
this material.

Trademark Acknowledgments
Boa, Ethernet, Internet Explorer, Linux, Microsoft, Mozilla, 
Netscape Navigator, OS/2, UNIX, Windows, WWW are registered 
trademarks of the respective holders. Java and all Java-based 
trademarks and logos are trademarks or registered trademarks of 
Sun Microsystems, Inc. in the United States and other countries. 
Axis Communications AB is independent of Sun Microsystems 
Inc. UPnP™ is a certification mark of the UPnP™ Implementers 
Corporation. 

Support
Should you require any technical assistance, please contact your 
Axis reseller. If your questions cannot be answered immediately, 
your reseller will forward your queries through the appropriate 
channels to ensure a rapid response. If you are connected to the 
Internet, you can:
• download user documentation and firmware updates
• find answers to resolved problems in the FAQ database. Search 

by product, category, or phrases
• report problems to Axis support by logging in to your private 

support area
• visit Axis Support at www.axis.com/techsup/

Safety Notice - Battery Replacement
The AXIS 210/211 uses a 3.0V CR2032 Lithium battery as the 
power supply for its internal real-time clock (RTC). Under normal 
conditions this battery will last for a minimum of 5 years. Low 
battery power affects the operation of the RTC, causing it to reset 
at every power-up. A log message will appear when the battery 
needs replacing.

The battery should not be replaced unless required!
If the battery does need replacing, please observe the following:
• Danger of Explosion if battery is incorrectly replaced
• Replace only with the same or equivalent battery, as 

recommended by the manufacturer.
• Dispose of used batteries according to the manufacturer's 

instructions.
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 5 AXIS 210/211 - Product Features
Product Features
The AXIS 210 and the AXIS 211 are part of the latest generation of fully featured Axis 
Network Cameras, all based on the AXIS ARTPEC-2 compression chip. The AXIS 211 
features a DC-Iris and support for Power over Ethernet (PoE). All instructions and 
information in this manual are valid for both cameras unless otherwise stated.

The video streams from the cameras are made available on the network as real-time, full 
frame rate Motion JPEG and/or MPEG-4 video streams. The cameras include Video Motion 
Detection, which can be used to trigger e.g. image uploads when there is activity in the 
video image. Uploads can also be scheduled to run at specified times. Security features 
include IP address filtering and multilevel password protection.

The cameras are equipped with an alarm input and an output, which can be connected to 
various external devices, e.g. door sensors and alarm bells. 

Video can be viewed in various different resolutions. Up to 20 viewers can access a camera 
simultaneously when using Motion JPEG. If MPEG-4 multicast is used, the number of 
viewers is unlimited, but each viewer still needs a separate MPEG-4 decoder license. There 
is one license included in the product, and additional licenses can be purchased separately.

The cameras have their own built-in web server, providing full access to all features 
through the use of a standard web browser. The built-in scripting tool allows the creation 
of basic applications. For advanced functionality, the cameras can be accessed via the 
AXIS HTTP API (more info at www.axis.com/developer).
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AXIS 211 - Extra Features

DC-Iris

The AXIS 211 features a varifocal 
DC-Iris, which automatically 
regulates the amount of light 
entering the camera. Tele/wide 
and focus are adjusted manually 
with the aid of the pullers 
mounted on the lens.

Power over Ethernet (PoE)

Supporting PoE network transformers conforming to IEEE 802.3af, the AXIS 211 can be 
powered directly from the network cabling. 
Download from Www.Somanuals.com. All Manuals Search And Download.



 7 AXIS 210/211 - Product Features
Overview

Power Connector - For connection of the PS-K power adapter (included).

I/O Connector - The I/O terminal connector provides the physical interface to one 
transistor output, one digital input and an auxiliary connection point for DC power. For 
more information, see The I/O Terminal Connector, on page 42.

Network Connector - The camera connects to the network via a standard network 
connector. Supporting NWAY, the camera detects the speed of the local network segment 
(10BaseT/100BaseTX Ethernet). This socket can also be used to power the AXIS 211 via 
PoE (Power over Ethernet). 

Serial Number - This number is used during installation. 

Control Button - Press this button to install using the AXIS Internet Dynamic DNS Service 
(see page 11) or to restore the factory default settings, as described in Resetting to the 
Factory Default Settings, on page 41.

Power connector

DC-Iris control cable 
(AXIS 211)

Rear panel
AXIS 211

connector
I/O terminal

Network connector
(and PoE for AXIS 211)

Status AXIS 210

Underside

indicator
AXIS 211

DC-Iris

Focus puller

Status
indicator

Tele/wide puller

Control 
cable 

Power indicator

Network indicator

Control button

Serial number

Mounting screw
hole
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 8 AXIS 210/211 - Product Features
LED Indicators

After completion of the startup and self test routines, the multi-colored Network, Status, 
and Power LED indicators flash as follows:

Network Amber Steady for connection to 10 Mbit/s network. Flashes for network activity.

Green Steady for connection to100 Mbit/s network. Flashes for network activity.

Red Flashes rapid red, together with the Status indicator, for hardware error.

Unlit No connection.

Status
Green Shows steady green for normal operation. Can be configured to flash green at intervals 

whenever the camera is accessed. See the online help for more information.

Unlit When configured for “no flash” on camera access. 

Amber Shows steady amber during reset to factory default or when restoring settings.

Red Slow flash for failed upgrade (see Emergency Recovery Procedure, on page 45). 
Rapid flash, together with the Network indicator, for hardware error. 

Power Green Normal operation.

Amber Flashes green/amber during firmware upgrade.
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Accessing the Camera
To use the AXIS 210/211 on your network, it must first be installed. Please see the AXIS 
210/211 Installation Guide, supplied with the product, or available from www.axis.com

The cameras can be used with most standard operating systems and browsers. The 
recommended browser is Internet Explorer with Windows, and Mozilla with other 
operating systems. See also the Technical Specifications, on page 49.

Notes: •To view streaming video in Microsoft Internet Explorer, you must set your browser to allow 
ActiveX controls and allow the AXIS Media Control (AMC) to be installed on your workstation. 
AMC is required to view MPEG-4 video streams. If your workstation restricts the use of addi-
tional software components, the cameras can be configured to use a Java applet for updating 
JPEG images. Please see the online help for more information.

•The AXIS 210/211 includes one (1) decoder license for viewing MPEG-4 video streams. This is 
automatically installed with AMC. The administrator can disable the installation of the MPEG-4 
decoder, to prevent unlicensed copies being installed. 

Access From a Browser
1. Start a browser (e.g. Internet 

Explorer, Mozilla)

2. Enter the IP address or host 
name of the cameras in the Location/Address field of your browser.

3. If this is the first time the camera is accessed, see Setting the Password, on page 
10. Otherwise enter your user name and password, as set by the administrator. 

4. The camera’s Live View page is now displayed in your browser. 

Note: If the layout of the Live View page has been customized to meet specific requirements, some of the exam-
ples and functions featured here may differ from those displayed on your own Live View page.
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Setting the Password
1. When accessing a camera for the first 

time, the ‘Configure Root Password’ 
dialog will be displayed on the screen.

2. Enter a password and then re-enter it, to 
confirm the spelling. Click OK.

3. The ‘Enter Network Password’ dialog will appear. Enter the User name: root
Note: The default administrator user name root is permanent and cannot be 
deleted.

4. Enter the password as set in step 2 above, and click OK. If the password is lost, 
the cameras must be reset to the factory default settings. See page 41.

5. If required, click Yes to install the AXIS Media Control (AMC). You will need 
administrator rights on the computer to do this.

Accessing the cameras from the Internet
Once installed, a camera is accessible on your local network (LAN). To access the camera from the Internet you must 
configure your broadband router to allow incoming data traffic. For security reasons this is usually done on a specific 
port. Please refer to the documentation for your broadband router for further instructions.

For more information, please visit the AXIS Internet Dynamic DNS Service at www.axiscam.net or, for Technical notes 
on this and other topics, visit the Axis Support Web at www.axis.com/techsup
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Focusing
To focus the AXIS 210, simply turn the adjustment ring on the lens until the focus is 
satisfactory. 

To focus the AXIS 211, follow the instructions below. 

1. From the Basic Configuration page in the setup tools, open the Focus adjustment 
page.

2. Set the DC-Iris to Disabled 
and click Save.

3. Unscrew the zoom puller on 
the lens by turning it 
anti-clockwise. Adjust the 
zoom setting as required. 
Re-tighten the zoom puller.

4. Unscrew the focus puller on 
the lens. Adjust the focus as 
required. Re-tighten the focus 
puller.

5. From the Focus adjustment page, set the DC-Iris to Enabled and click Save.

Note: The DC-Iris should always be disabled while focusing the camera. This opens the iris to its maximum, which 
gives the smallest depth of field and thus the best conditions for correct focusing. When the focus is set 
with this method it will then be maintained in any light conditions.

AXIS 211

Focus puller

Zoom puller
(Tele/wide)
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The Live View Page
Depending on whether or not the Live View page has been customized, the buttons 
described below may or may not be visible.

To resize the video image, click the View Size buttons: half-size (x1/2), 
full-size (x1), x2 or x4. Note that this does not change the video 
image’s resolution, but simply how it is displayed. Changing the View 
size is not available in Sequence Mode.

The Video Format drop-down list allows the video format on the Live 
View page to be temporarily changed. 

The Output buttons control the output directly from the Live View page. 
These buttons are configured under Setup > Live View Config > Layout.

Pulse - click this button to activate the port for a defined period of time, e.g. to 
switch on a light for 20 seconds.
Active/Inactive - click these buttons to manually start and stop a connected 
device, e.g. switch a light on/off.

These buttons start and stop the Sequence Mode. This mode is created in 
Setup > Live View Config > Sequence mode, and automatically displays the 
view from 2 or more video sources at set intervals.

From the Source list, select the desired external video source. Note 
that Sequence Mode must be stopped before selecting a source from 
this list.

The Action buttons can trigger an event directly from the Live View page. 
These are configured under Setup > Live View Config > Layout.

The Snapshot button saves a snapshot of the video image currently being 
displayed. Right-click on the video image to save it in JPEG format on your 
computer. This button is primarily intended for use when the AMC viewer 
toolbar is not available.
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The AMC viewer toolbar (AXIS Media Control) is available in Microsoft Internet 
Explorer only. It displays the following buttons:

The Play/Stop button starts and stops the live video stream.

The Snapshot button saves a snapshot of the video image currently being 
displayed. The Snapshot function and the target directory for saving snapshots can 
be configured from the AMC Control Applet in the Windows Control Panel 
(Internet Explorer only).

Click the View Full Screen button to make the video image fill the entire screen 
area. No other windows will be visible. Press Esc (Escape) on the computer 
keyboard to exit full screen.
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Video Streams
The AXIS 210/211 provides several different image and video stream formats. The type to 
use depends on your requirements and on the properties of your network. 

The Live View page in the AXIS 210/211 provides access to Motion JPEG and MPEG-4 
video streams, as well as to single JPEG images. Other applications and clients can also 
access these video streams/images directly, without going via the Live View page. 

Stream Types

Motion JPEG
This format uses standard JPEG still images for the video stream. These images are then 
displayed and updated at a rate sufficient to create a stream that shows constantly updated 
motion. 

The Motion JPEG stream uses considerable amounts of bandwidth, but also provides 
excellent image quality and access to each and every individual image contained in the 
stream.

Note also that multiple clients accessing Motion JPEG streams can use different image 
settings.

MPEG-4
This is a video compression standard that makes good use of bandwidth, and which can 
provide high-quality video streams at less than 1 Mbit/s. 

Notes: •MPEG-4 is licensed technology. The AXIS 210/211 includes one viewing client license. 
Installing additional unlicensed copies of the viewing client is prohibited. To purchase addi-
tional licenses, contact your Axis reseller.

•All clients viewing the MPEG-4 stream must use the same image settings.

The MPEG-4 standard provides scope for a large range of different coding tools for use by 
various applications in different situations, and the AXIS 210/211 provides certain subsets 
of these tools. These are represented as Video object types, which are selected for use with 
different viewing clients. The supported video object types are:

• Simple - sets the coding type to H.263, as used by e.g. QuickTime™. 
• Advanced Simple - sets the coding type to MPEG-4 Part 2, as used by AMC (AXIS 

Media Control) 

When using MPEG-4 it is also possible to control the bit rate, which in turn allows the 
amount of bandwidth usage to be controlled. CBR (constant bit rate) is used to achieve a 
specific bit rate by varying the quality of the MPEG-4 stream. When using VBR (variable 
bit rate), the quality of the video stream is kept as constant as possible, at the cost of a 
varying bit rate. 
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MPEG-4 protocols and communication methods
To deliver live streaming video over IP networks, various combinations of transport 
protocols and broadcast methods are employed.

• RTP (Realtime Transport Protocol) is a protocol that allows programs to manage the 
real-time transmission of multimedia data, via unicast or multicast. 

• RTSP (Real Time Streaming Protocol) serves as a control protocol, to negotiate which 
transport protocol to use for the stream. RTSP is thus used by a viewing client to start a 
unicast session, see below.

• UDP (User Datagram Protocol) is a communications protocol that offers limited service 
for exchanging data in a network that uses the Internet Protocol (IP). UDP is an alterna-
tive to the Transmission Control Protocol (TCP). The advantage of UDP is that it is not 
required to deliver all data and may drop network packets when there is e.g. network 
congestion. This is suitable for live video, as there is no point in re-transmitting old 
information that will not be displayed anyway.

• Unicasting is communication between a single sender and a single receiver over a net-
work. This means that the video stream goes independently to each user, and each user 
gets their own stream. A benefit of unicasting is that if one stream fails, it only affects 
one user.

• Multicast is bandwidth-conserving technology that reduces bandwidth usage by simul-
taneously delivering a single stream of information to multiple network recipients. This 
technology is used primarily on delimited networks (intranets), as each user needs an 
uninterrupted data flow and should not rely on network routers.

How to stream MPEG-4?
Deciding on the combination of protocols and methods to use depends on your viewing 
requirements, and on the properties of your network.

RTP+RTSP 
This method (actually RTP over UDP and RTSP over TCP) should be your first consideration 
for live video, especially when it is important to always have an up-to-date video stream, 
even if some images do get dropped. This can be configured as multicast or unicast. 

Multicasting provides the most efficient usage of bandwidth, especially when there are 
large numbers of clients viewing simultaneously. Note however, that a multicast broadcast 
cannot pass a network router unless the router is configured to allow this. It is thus not 
possible to multicast over e.g. the Internet. 

Unicasting should be used for video-on-demand broadcasting, so that there is no video 
traffic on the network until a client connects and requests the stream. However, if more 
and more unicast clients connect simultaneously, the AXIS 210/211 will at some point 
become overloaded. There is also a maximum of 20 simultaneous viewers to be considered.
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RTP/RTSP
This unicast method is RTP tunneled over RTSP. This can be used to exploit the fact that it 
is relatively simple to configure firewalls to allow RTSP traffic.

RTP/RTSP/HTTP or RTP/RTSP/HTTPS
These two methods can also be used to traverse firewalls. Firewalls are commonly 
configured to allow the HTTP protocol, thus allowing RTP to be tunneled.

The AXIS Media Control 
The recommended method of accessing live video (MPEG-4 and/or Motion JPEG) from the 
AXIS 210/211 is to use the AXIS Media Control (AMC) in Microsoft Internet Explorer in 
Windows. This ActiveX component is automatically installed on first use, after which it 
can be configured by opening the AMC Control Panel applet from the Windows Control 
Panel. Alternatively, right-click the video image in Internet Explorer.

Other methods of accessing the video stream
Video/images from the AXIS 210/211 can also be accessed in the following ways:

• If supported by the client, the AXIS 210/211 can use Motion JPEG server push to dis-
play video. This option maintains an open HTTP connection to the browser and sends 
data as and when required, for as long as required. 

• As single JPEG images in a browser. Enter e.g. the path: 
http://<ip>/axis-cgi/jpg/image.cgi?resolution=320x240

• Windows Media Player. This requires AMC and the MPEG-4 viewing client to be 
installed. The paths that can be used are listed below in the order of preference.

• Unicast via RTP: axrtpu://<ip>/mpeg4/media.amp
• Unicast via RTSP: axrtsp://<ip>/mpeg4/media.amp
• Unicast via RTSP, tunneled via HTTP: axrtsphttp://<ip>/mpeg4/media.amp 
• Unicast via RTSP, tunneled via HTTPS: axrtsphttps://<ip>/mpeg4/media.amp 
• Multicast:  axrtpm://<ip>/mpeg4/media.amp

Note: <ip> = IP address
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Other MPEG-4 clients
Although it may be possible to use other clients to view the MPEG-4 stream, this is not 
guaranteed by Axis. 

For some other clients, e.g. QuickTime™ the Video Object Type must be set to Simple. It 
may also be necessary to adjust the advanced MPEG-4 settings.

To assess the video stream from e.g. QuickTime™ the following path can be used:

rtsp://<ip>/mpeg4/media.amp 

This path is for all supported methods, and the client will negotiate with the video server to 
determine exactly which transport protocol to use.

Note: <ip> = IP address
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Configuration
This section describes how to configure the camera, and is intended for product 
Administrators, who have unrestricted access to all the Setup tools, and Operators, who 
have access to the settings for Video & Image, Live View Config and Event Configuration.

The camera is configured under Setup from a standard browser (see Technical 
Specifications, on page 49).

Accessing the Setup tools
Follow the instructions below to access the Setup Tools from a browser.

1. Start your browser and enter 
the IP address or host name 
of the camera in the 
location/address field.

2. The Live View page is now displayed. Click Setup to display the Setup tools.

Setup tools
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Video and Image settings
The following descriptions offer examples of the features available in the cameras. For 
details of each setting, please refer to the online help available from the setup tools. Click 

 to access the online help.

Image Appearance

Use these settings to change the image as required.

The configuration of the video image and overlays will affect the camera’s overall 
performance, depending on how it is used and on the available bandwidth. Lower 
compression improves video image quality, but increases the bandwidth. 

The video image can be rotated and also fine-tuned by adjusting the color level, the 
brightness and the contrast. Please see the online help for further information on these 
settings. 
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Overlay Settings

Use these settings to include a) 
an image as an overlay, and/or 
b) the date and time, along with 
text of your own. 

Text overlays are all included 
on one line at the top or bottom 
of the video image. Image 
overlays can be placed 
anywhere in the video image. 

To upload an overlay image, see 
below.

Note: If there is information in a moni-
tored area that you do not wish to 
disclose, you can mask it out by placing an overlay image on top. Setting the overlay image anywhere in the 
video image using coordinates allows precision detail masking.

Video Stream

Set the video stream time as unlimited, by selecting the Unlimited radio button, or define 
a maximum time per session, in seconds, minutes or hours. When the set time has expired, 
a new stream can be started by refreshing the page in the browser. 

The frame rate allowed to each viewer can also be limited, to avoid bandwidth problems 
on the network. To allow the highest available frame rate, select the Unlimited radio 
button. 

Test 

For a preview of the image and overlay settings before saving, click Test. When satisfied 
with the settings, click Save. Please note that the preview image will be in JPEG format, 
even though the settings are valid both for Motion JPEG and MPEG-4.

Overlay Image Settings

An overlay image is an image superimposed over the video image. 

Follow these instructions to upload and use an overlay image:

1. To upload the file (the image) to the AXIS 210/211, click the Browse button and 
locate it on your computer or server. 

2. Click the Upload button and follow the on-screen instructions.

3. The image is now available in the Use overlay image drop-down list.

4. Click Save.

Overlay image

Text, date and time overlays 
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Overlay image requirements:

Overlay image limitations: 

Please refer to the online help for more information. 

Advanced - Camera Settings

These pages includes different settings for fine-tuning the video image. Note that the 
advanced settings available depend on the camera model.

To compensate for the lighting conditions the white balance and exposure control can be 
adjusted. The DC-Iris (AXIS 211 only) should always be enabled except during focusing, or 
when using a non-DC-Iris lens.

The settings for Low light behavior determine how the camera will behave at low light 
levels. These settings all affect video image quality and are basically a measure of how 
much noise to allow in the video images.

Please see the online help for further instructions on these settings. 

Advanced - MPEG-4 Settings

Tools for adjusting the MPEG-4 settings and for controlling the video bit rate. 

The MPEG-4 standard provides many different coding tools for various applications in 
different situations. As most MPEG-4 clients do not support all of these tools, it is usual to 
instead define and use subsets for different clients or groups of clients. These settings allow 
you to define the type of viewing client to use.

Adjusting the maximum bit rate and setting it to variable or constant is a good way of 
controlling the bandwidth used by the MPEG-4 video stream. For more information on 
these advanced settings, please see the online help. For more information on MPEG-4, see 
Video Streams, on page 14. 

Image Formats Image Size

• Windows 24-bit BMP (full color)

• Windows 4-bit BMP (16 colors)

The height and width of the overlay image in 
pixels must be exactly divisible by 4.

• The maximum overlay image size supported by the camera is 640x480, even when using a lower resolution. The overlay 
is automatically rescaled along with the image. See also the Technical Specifications, on page 49.

• Note that when a text overlay is also used, this reduces the amount of space available to the overlay image. To keep the 
text readable at lower resolutions, the text overlay occupies proportionally more and more space, i.e., 16 pixels in height 
at 640x480, 32 pixels at 320x240 and 64 pixels at 160x120. 

• If the overlay is initially positioned so that part of it is outside the video image, it will be relocated so that it appears 
over the video image, i.e. it is always the entire image that is displayed.
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AXIS Media Control
The AXIS Media Control (AMC) is installed automatically the first time the camera is 
accessed from a browser. The AMC control panel can be opened by right-clicking on the 
video image in the Live View web page. The AMC control panel can be used to configure 
various video settings. Please see the readme file included in the tool for more information. 
Download from Www.Somanuals.com. All Manuals Search And Download.



 23 AXIS 210/211 - Live View Config
Live View Config

Layout
These are the tools for deciding the 
layout of the Live View page. 

The layout can be set in 3 ways:

• Use Axis look - the layout is 
unchanged.

• Use custom settings - modify 
the Axis look, with your own 
colors, images etc. Click the 
Configure button and see below.

• Own Home Page - Upload and 
use your own custom page as the 
default web page. Click the 
Configure button and see below.

The other settings on this page 
mainly concern which features (e.g. 
buttons and links) to include. See 
page 25 for more information.

Customizing the default page

The appearance of the 
default Live View page 
can be customized to 
suit your own 
requirements, or you 
can upload and use 
your own home page. 

To upload your own 
files, click the 
Upload/Remove button 
and see the instructions 
below.
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Upload Own Web Files

Your own web files, background pictures, etc., must first be uploaded to the camera in 
order to be available for selection in the Custom Settings setup dialog. Once uploaded, the 
files are shown in the drop-down lists.

1. Click the Upload/Remove button.

2. Enter the path to the file, e.g. a file located on your workstation or click the 
Browse button.

3. Select the user level for the uploaded file. Setting the user access level means that 
you have complete control over which pages can be viewed by which users.

4. When the path is shown correctly in the text field, click the Upload button.

All uploaded files are shown in the list in the lower section of the page. To remove a file, 
check the box provided next to it and then click the Remove button.

Unchecking the box for Show setup link will remove the setup link from the product's 
Home Page. The Setup Tools will then only be accessible by entering the full setup address 
into the address/URL field of a browser.

To use a previously uploaded web page as the default page, check the box, select the page 
from the drop-down list and click OK. 

If the setup link is missing, setup can be reached at this URL: 
http://<ip address>/operator/basic.shtml. 
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User-defined Links

Enter a descriptive name and enter the URL in the provided field. 

Example

1. Check Show Custom Link 1

2. Enter a descriptive name, e.g. My Website

3. Check the radio button for web link.

4. Enter the web link: e.g. http://www.example.com and then click Save.

This link will then be shown on the Live View page and will open the specified website.

User-defined CGI links can be used to issue advanced commands via the Axis HTTP API. 
For more information, see the Developer pages at www.axis.com/developer

Action Buttons

The manual trigger buttons can be used to manually trigger and stop an event from the 
Live View page. See Event Configuration, on page 30.

Enabling the display of the Snapshot button allows users to save a snapshot from the 
video stream by clicking the button. This button is mainly intended for use with browsers 
other than Internet Explorer, or when otherwise not using AXIS Media Control (AMC) to 
view the video stream. AMC (an ActiveX control) for Internet Explorer provides its own 
snapshot button. 

Output Buttons

These buttons can be used to manually activate the output from the Live View page, e.g. to 
switch a light on and off. There are 2 options for how the output is activated:

• The Pulse button activates the output for a defined period
• Active/Inactive displays 2 buttons, one for each action (on/off)

User-defined link
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Default Video Format in Internet Explorer for Windows

Select the default format to use on the Live View page. Checking the box for Show video 
format selection displays a drop-down list on the Live View page allowing you to 
temporarily change the format. 

When using MPEG-4 as the video format, the default viewer is AXIS Media Control with 
Internet Explorer.

Note: It is also possible to view Motion JPEG when MPEG-4 is chosen as default, and vice versa.

AMC (AXIS Media Control) Settings

Checking the Show viewer toolbar box displays the AMC toolbar under the video stream. 
This toolbar is only available when using AMC. See also AXIS Media Control, on page 22.

By checking the Enable MPEG-4 decoder installation box, it is also possible for the 
Administrator to enable or disable the installation of the MPEG-4 decoder. This is used to 
prevent the installation of unlicensed copies. Further decoder licenses can be purchased 
from your Axis dealer.

Default Viewer for Motion JPEG

Select the appropriate radio button to define the method for viewing moving video images, 
depending on your browser and settings.

Please see the online help for more information.

HTML Examples
You can add live video from your AXIS 210/211 to your own web site. The camera can 
send Motion-JPEG or MPEG-4 images to up to 20 simultaneous connections, although an 
administrator can restrict this to fewer. Note that this does not affect or include the 
number of multicast viewers.

On the HTML examples page, select the required video format. For Motion JPEG, 
optionally modify the settings for image size, compression, etc., and then click Update. 
The camera then generates the required source code for your configuration. Copy this code 
and paste it into your own web page code. 

If MPEG-4 multicasting is used, the video stream will be available to the viewers connected 
to the parts of the network where multicast is enabled. Please note that a separate MPEG-4 
decoder license is required for each viewer.
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External Video
The camera can also display video images from other Axis network cameras and video 
servers. These are known as External Video sources. Each external video source is 
available from the drop-down list on the Live View page. 

Click the Add button to open the External Video Source Setup dialog, which is used to 
make all the necessary settings. Enter the IP address or host name of the external video 
source you wish to add. The user can then choose to receive either MPEG-2, MPEG-4 or 
Motion JPEG video stream.

Sequence Mode
The Live View page can be configured to rotate through the internal and selected external 
video sources, in order, or randomly.

Select the desired video sources and enter the time in seconds to display each source (up to 
59 minutes). Click Save.

The Sequence buttons will appear on the Live View page to enable the viewer to start and 
stop the sequence mode.

Please see the online help for more information.
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Event Configuration
An event in the camera is when an Event Type is activated and causes certain actions to 
be performed. The event type is the set of parameters (or conditions) that specifies how and 
when which actions will be performed. A common event type is when the camera uploads 
images when an alarm occurs. Many event types use an Event Server, to e.g. upload 
images to.

This section describes how to set up event servers and event types, i.e. how to configure 
the camera to perform certain actions when events (e.g. alarms) occur.

Definitions

Event Servers
Event Servers are used to receive e.g. uploaded image files and/or notification messages. 
To set up Event server connections in your camera, go to Setup > Event Configuration > 
Event Servers and enter the required information for the required server type.

For details on each setting, please see the online help  available from each web page.

When the setup is complete, the connection can be tested by clicking the Test button (the 
connection test takes approximately 10 seconds). 

Event type A set of parameters describing how and when the camera will perform certain actions

Triggered Event - see page 31
The circumstances that start an event. E.g. on a signal from an external device, such as a 

door switch or a motion sensor.

Scheduled Event - see page 32 The circumstances that start an event. E.g. at a pre-programmed time.

Action
What occurs when the event triggers. E.g. the upload of images to an FTP server, email noti-

fication, etc.

Server type Purpose Information required

FTP Server • Receives uploaded images • Descriptive name of your choice
• Network address (IP address or host name)
• User Name and Password (for FTP server)
• Upload path e.g. images/
• Port number
• Use passive mode if there is a firewall between the camera 

and FTP server

HTTP Server • Receives notification messages
• Receives uploaded images

• Descriptive name of your choice
• URL (IP address or host name)
• User Name and Password (for HTTP server)
• Proxy address/Proxy port (if required)
• Proxy User Name and Password (if required)

TCP Server • Receives notification messages • Descriptive name of your choice
• Network address (IP address or host name)
• User Name and Password (for TCP server)
• Port number
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Configuring Event 
Types

An Event Type describes 
how and when the camera 
will perform certain actions.

Example: If somebody passes in 
front of the camera and an event that 
uses motion detection has been con-
figured to act on this, the camera can 
e.g. record and save images to an FTP server, and/or send a notification email to a pre-configured email address 
with a pre-configured message. Images can be sent as email attachments.

Triggered Event

A Triggered event can be activated by e.g:

• a push button connected to the camera’s input port
• detected movement in a configured motion detection window
• a manually activated action, e.g. from an action button in the web interface
• on restart (reboot) after e.g. power loss

How to set up a triggered event

This example describes how to set up the camera to upload images when e.g the main door 
is opened:

1. Click Add triggered on the Event types page.

2. Enter a descriptive name for the event, e.g. Main door open.

3. Set the priority - High, Normal or Low (see the online help).

4. Set the Respond to Trigger... parameters for when the event will be active, 
e.g. only after office hours.

5. Select the trigger alternative from the Triggered by... drop-down list, e.g. select 
Input ports, for a sensor connected to the door.

6. Set the When Triggered... parameters, i.e. define what the camera will do if the 
main door is opened e.g., upload images to an FTP server.

7. Click OK to save the Event in the Event Types list.

Please see the online help for descriptions of each available option.

Note: Up to 10 event types can be configured in the camera, and up to 3 of these can be configured to upload 
images.
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Pre-trigger and Post-trigger buffers

This function is very useful when checking to see what happened immediately before 
and/or after a trigger, e.g. 30 seconds before and/or after a door was opened. Check the 
Upload images checkbox under Event Types > Add Triggered... > Triggered by... to 
expand the web page with the available options. All uploaded images are JPEG images.

Include pre-trigger buffer - images stored internally in the server from the time 
immediately preceding the trigger. Check the box to enable the pre-trigger buffer, enter the 
desired length of time and specify the required image frequency. 

Include post-trigger buffer - contains images from the time immediately after the trigger. 
Configure as for pre-trigger. 

Notes: •Pre-trigger and Post-trigger buffers will be lost if the connection to the event server fails.

•The maximum length of the pre-/post-buffer depends on the video image size and selected frame rate.

•If the pre- or post-buffer is too large for the camera’s internal memory, the frame rate will be reduced and 
individual images may be missing. If this occurs, an entry will be created in the unit's log file.

Continue image upload (unbuffered) - enables the upload of video images for a fixed 
length of time. Specify the length of time for the uploaded recording, in seconds, minutes 
or hours, or for as long as the trigger is active. Finally, set the desired image frequency to 
the maximum (the maximum available) or to a specified frame rate. The frame rate will be 
the best possible, but might not be as high as specified, especially if uploading via a slow 
connection.

Scheduled Event

A Scheduled event can be activated at preset times, in a repeating pattern on selected 
weekdays.

Configuration example: 

1. Click Add scheduled on the Event types page.

2. Enter a descriptive name for the event, e.g. “Scheduled email upload.”

3. Set the priority (High, Normal or Low).

4. Set the Activation Time parameters (24h clock) when the event will be active, 
e.g. start on Sundays at 13.00 with a duration of 12 hours.

5. Set the When Activated... parameters, i.e. set what the camera will do at the 
specified time, e.g. send uploaded images to an email address.

6. Click OK to save the Event in the Event Types list.

Please see the online help for descriptions of each available option.
Download from Www.Somanuals.com. All Manuals Search And Download.



 33 AXIS 210/211 - Event Configuration
Motion Detection
The motion detection feature is used to generate an alarm whenever movement occurs (or 
stops) in the video image. A total of 10 Include and/or Exclude windows can be 
configured.

• Included windows target specific areas within the whole video image
• Excluded windows define areas within an Include window that should be ignored 

(areas outside Include windows are automatically ignored)
Once configured, the motion detection windows will appear in the list of available triggers, 
for triggering events. See How to set up a triggered event above.

Note: Using the motion detection feature may decrease the camera’s overall performance.

How to configure Motion Detection

1. Click Motion Detection in the Event Configuration menu.

2. Click the Configure Included Window radio button.

3. Click New.

4. Enter a descriptive name under Window name.

5. Adjust the size (drag the bottom right-hand corner) and position (click on the text 
at the top and drag to the desired position).

6. Adjust the Object size, History and Sensitivity profile sliders (see table below for 
details). Any detected motion within an active window is then indicated by red 
peaks in the Activity window (the active window has a red frame).
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7. Click Save.

Please see the online help for descriptions of each available option.

Examples: 

• Avoid triggering on small objects in the video image by setting the object size level to high.
• To reduce the number of triggers if there is a lot of movement during a short period of time, select a high 

history level.
• To only detect flashing light, low sensitivity can be selected. In other cases, a high sensitivity level is 

recommended.

Port Status
Under Event Configuration > Port Status there is a list showing the status for the camera’s 
input and output. This is for the benefit of Operators, who have no access to the System 
Options section.

Example: If the Normal state for a push button connected to an input is set to Open circuit - as long as the but-
ton is not pushed, the state is inactive. If the button is pushed, the state of the input changes to 
active.

To exclude parts of the Include window, click the Configure Excluded Windows button 
and position the Exclude window as required, within the Include window.

 Object Size History Sensitivity
High level Only very large objects 

trigger motion detection
An object that appears in the region will 
trigger the motion detection for a long 
period

Ordinary colored objects on ordinary 
backgrounds will trigger the motion 
detection

Low level Even very small objects 
trigger motion detection

An object that appears in the region will 
trigger motion detection for only a very 
short period

Only very bright objects on a dark back-
ground will trigger motion detection

Default value Low Medium to High Medium to High
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System Options

Security
User access control is enabled by default. An administrator can set up other users, by 
giving these user names and passwords. It is also possible to allow anonymous viewer 
login, which means that anybody may access the Live View page, as described below:

Users - the user list displays the authorized users and user groups (levels):

User Settings - check the relevant checkboxes to enable:

• Anonymous viewer login - allows any viewer direct access to the Live View 
page.

• Maximum number of simultaneous viewers - enter a value here to restrict the 
number of Motion JPEG viewers accessing the unit. This is useful if you need to 
save on bandwidth. Note that the limit of 20 users does not affect or include the 
number of multicast viewers.

IP Address Filter

The administrator can add up to 256 IP addresses to the Allowed IP Addresses list. If the IP 
address filtering checkbox is checked, only the IP addresses in the list will be allowed 
access to the camera.

The users from these IP addresses need to be specified in the user list with the appropriate 
access rights (User, Operator or Administrator).

Referrals - to prevent unauthorized clients from including the video stream from the 
camera into external Web pages, check the Referrals checkbox and enter the IP address or 
Host name of the computer that hosts the Web pages with the included video stream. 
Several IP addresses/host names can be defined and are separated by semicolons (;). This 
option is only applicable to Motion JPEG video streams.

Notes: •If the referrals feature is enabled and you wish to also allow normal access to the Live View 
page, the product's own IP address or host name must be added to the list of allowed referrers.

•Restricting referrers has no effect on an MPEG-4 video stream. To restrict an MPEG-4 stream, IP 
address filtering must be enabled.

•Restricting referrers is of greatest value when not using IP address filtering. If IP address filter-
ing is used, then the allowed referrers are automatically restricted to those allowed IP 
addresses.

Viewer Provides the lowest level of access, which only allows access to the Live View page.
Operator An Operator can view the Live View page, create and modify event types and adjust certain other 

settings. Operators have no access to the System Options.
Administrator An administrator has unrestricted access to the Setup Tools and can determine the registration of 

all other users. 
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Date & Time
Current Server Time - displays the current date and time (24h clock). The time can be 
displayed in 12h clock format in the Overlay Images (see below).

New Server Time - Select your time zone from the drop-down list. If you want the server 
clock to automatically adjust for daylight savings time, select the Automatically adjust for 
daylight saving time changes. This adjustment works for all methods.

From the Time Mode section, select the preferred method to use for setting the time:

• Synchronize with computer time - sets the time from the clock on your 
computer. 

• Synchronize with NTP Server - the camera will obtain the time from an NTP 
server every 60 minutes. Specify the NTP server's IP address or host name.

• Set manually - this option allows you to manually set the time and date.

Note: Note that if using a host name for the NTP server, a DNS server must be configured under TCP/IP settings. 
See Network > TCP/IP below.

Date & Time Format Used in Images - specify the formats for the date and time (12h or 
24h) displayed in the Live View video streams.

Use the predefined formats or use your own custom date and time formats. See Advanced 
File Naming & Date/Time Formats in the help files for information on how to create 
your own file formats.

Network - Basic TCP/IP Settings

IP Address Configuration

The camera’s IP address can be set automatically via DHCP, or a fixed IP address can be set 
manually. A host name can be used and there are options for setting up notification of 
changes in the IP address. DHCP is enabled by default.

Notes: •DHCP is a protocol for automatic IP address assignment on a network. IP address assignment via 
DHCP may lead to the situation where the IP address changes and you lose contact. Configure 
the options for notification of IP address change (under Services) to receive notification from 
the video server when the IP address changes.

•Alternatively, if your DHCP server can update a DNS server, you can access the AXIS 210/211 by 
host name which is always the same, regardless of the IP address.
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Services

Options for notification of IP address change - if the IP address for the video server 
changes, e.g. automatically by DHCP, you can choose to be notified of the change. Click 
Settings... and enter the required information.

AXIS Internet Dynamic DNS Service - If the AXIS 210/211 Video Server has been 
registered with the Axis Internet Dynamic DNS service and the IP address for the product 
changes, the service is updated to reflect the change. Check the box to enable/disable 
automatic updates.

The domain name currently registered at the Axis Internet Dynamic DNS service for your 
product can at any time be removed. To do this click Settings... and follow the 
instructions. 

For more information, please refer to the online help .

Network - Advanced TCP/IP Settings

DNS Configuration

DNS (Domain Name Service) provides the translation of host names to IP addresses on your 
network.

Obtain DNS server address via DHCP - automatically use the DNS server settings provided 
by the DHCP server. Click the View button to see the current settings.

Use the following DNS server address - enter the desired DNS server by specifying the 
following:

Domain name - enter the domain(s) to search for the host name used by the AXIS 
210/211. Multiple domains can be separated by semicolons (;). The host name is always the 
first part of a Fully Qualified Domain Name, e.g. myserver is the host name in the Fully 
Qualified Domain Name myserver.mycompany.com where mycompany.com is the 
Domain name.

DNS servers - enter the IP addresses of the primary and secondary DNS servers.

Host Name Configuration

The AXIS 210/211 can be accessed using a host name, instead of an IP address. The host 
name is usually the same as the assigned DNS Name.

For more information, please see the online help
Download from Www.Somanuals.com. All Manuals Search And Download.



 38 AXIS 210/211 - System Options
Link-Local Address

This is enabled by default and assigns the AXIS 210/211 an additional IP address for use 
with UPnP™. The AXIS 210/211 can have both a Link-Local IP and a static/DHCP-supplied 
IP address at the same time - these will not affect each other. 

HTTP 

The default HTTP port number (80) can be changed to any port within the range 
1024-65535. This is useful for e.g. simple security port mapping.

RTSP

The RTSP protocol allows a connecting client to start an MPEG-4 stream. Enter the RTSP 
port number to use. The default setting is 554.

Network Traffic 

The default setting is Auto-negotiate which means that the correct speed is automatically 
selected. If necessary, you can set the connection speed by selecting it from the drop-down 
list.

Maximum bandwidth - Specify, in Mbit/s or kbit/s, the maximum bandwidth that the 
AXIS 210/211 is allowed to use on your network. This is a useful function when 
connecting the camera to busy or heavily loaded networks. The default setting is 
Unlimited.

Note: When using MPEG-4 as the video format, remember that setting a maximum bandwidth value here may 
create problems for individual video streams if the maximum value is less than the sum of the bit rates set 
for the video streams. 

For more information, please see the online help .

SOCKS 
SOCKS is a network proxy protocol. The camera can be configured to use a SOCKS server 
to reach networks on the other side of a firewall/proxy server. This functionality is useful 
if the camera is located on a local network behind a firewall, but notifications, uploads, 
alarms, etc., need to be sent to a destination outside the local network (e.g. to the Internet).

SMTP (email)
Enter the host names or addresses for your primary and secondary mail servers in the 
fields provided, to enable the sending of event and error email messages from the camera 
to predefined addresses via SMTP.
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UPnP™
The AXIS 210/211 includes support for UPnP™, which is enabled by default. If also enabled 
on your computer, the camera will automatically be detected and a new icon will be added 
to “My Network Places.” 

Note: UPnP must also be enabled on your Windows XP or ME computer. To do this, open the Control Panel from 
the Start Menu and select Add/Remove Programs. Select Add/Remove Windows Components and open 
the Networking Services section. Click Details and then select UPnP as the service to add.

RTP (multicast) MPEG-4
These settings are the IP address, port number, and Time-To-Live value to use for the video 
stream(s) in multicast MPEG-4 format. Only certain IP addresses and port numbers should 
be used for multicast streams. For more information, please see the online help.

Ports & Devices
I/O Ports - the pinout, interface support and the control and monitoring functions 
provided by this connector are described in The I/O Terminal Connector, on page 42.

LED Settings
The Status indicator LED on the front of the camera can be set to flash at a configurable 
interval (or to not light up at all) whenever the unit is accessed. For a listing of all LED 
behavior, see page 8, or the online help.

Note: The LED does not flash when the stream is retrieved via MPEG-4 multicast.

Maintenance
• Restart - The camera is restarted without changing any of the settings. Use this method 

if the unit is not behaving as expected.
• Restore - The unit is restarted and most current settings are reset to factory default val-

ues. The settings that will not be reset are as follows:
• the boot protocol (DHCP or static)
• the static IP address
• the default router
• the subnet mask
• the system time

• Default - The default button should be used with caution. Pressing this will return all of 
the camera's settings to the factory default values (including the IP address)

Upgrade Server - See Upgrading the Firmware, on page 44.
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Backup - To take a backup of all of the parameters, and any user-defined scripts, click this 
button. If necessary, it will then be possible to return to the previous settings, if settings 
are changed and there is unexpected behavior.

Restore - click the Browse button to locate the saved backup file (see above) and then click 
the Restore button. The settings will be restored to the previous configuration.

Note: Backup and Restore can only be used on the same unit running the same firmware. This feature is not 
intended for the configuration of multiple units or for firmware upgrades.

Support
The support overview page provides valuable information on troubleshooting and contact 
information, should you require technical assistance.

Logs & Reports - when contacting Axis support, please be sure to provide a valid Server 
Report with your query.

View Information - The Log file, the Server Report and the Parameter List all provide 
valuable information for troubleshooting and when contacting Axis support.

Configuration

Log Level for Log Files - from the drop-down list, select the level of information to be 
added to the Log file

Log Level for Email - from the drop-down list, select the level of information to send as 
email and enter the destination email address.
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Resetting to the Factory Default Settings
To reset the camera to the original factory default settings, go to the System Options > 
Maintenance web page (as described in Maintenance, on page 39) or use the Control 
button on the underside of the camera (see page 7) as described below:

Using the Control Button

To reset the camera to the factory default settings using the Control Button:

1. Disconnect the power adapter, or the network cable if using PoE 
(AXIS 211 only).

2. Press and hold the Control button while reconnecting the power.

3. Keep the Control button pressed until the Status Indicator color changes to amber 
(this may take up to 15 seconds).

4. Release the Control button.

5. When the Status Indicator changes to Green (which may take up to 1 minute), the 
process is complete and the camera has been reset. The unit will now have the 
default IP address 192.168.0.90

Advanced
Scripting is an advanced function that provides the possibility to customize and use 
scripts. This function is a very powerful tool. 

Caution!
Improper use may cause unexpected behavior or even cause loss of contact with the 
unit. If a script does cause problems, reset the unit to its factory default settings. A 
backup file may be of use to return the unit to its latest configuration.

Axis strongly recommends that you do not use this function unless you fully 
understand the consequences. Note that Axis support does not provide assistance for 
problems with customized scripts. 

For more information, please visit the Developer pages at www.axis.com/developer

Plain Config - this function is for the advanced user with experience of Axis video 
server configuration. All parameters can be set and modified from this page. Help is 
available from the standard help pages.
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The I/O Terminal Connector

Pinout and Interface
The 4-pin I/O terminal connector provides the interface to: 

• 1 transistor output
• 1 digital input
• auxiliary power and GND

The terminal connector is used in applications for e.g. motion detection, event triggering, 
time lapse recording, alarm notification via email, image storage to FTP locations, etc.

• Input - for connecting e.g. a doorbell. If the doorbell is pressed, the state changes 
and the input becomes active (shown under Event Configuration > Port Status).

• Output - connects e.g. an alarm device that can be activated by Output buttons 
on the Live View page, or by an Event Type. The output will show as active 
(Event Configuration > Port Status) if the alarm device is activated.

Pin Function Description
4 Transistor Output With a maximum load of 100mA and a maximum voltage of 24V DC, this output 

has an open-collector NPN transistor with the emitter connected to pin 1 (GND). 
If used with an external relay, a diode must be connected in parallel with the load, 
for protection against voltage transients.

3 Digital Input Connect to GND to activate, or leave floating (or unconnected) to deactivate.

2 Auxiliary DC Power Input 7-20 VDC/min 7W. Electrically connected in parallel with the PS-K power 
connector, this pin provides an auxiliary connector for mains power to the unit. If 
the unit is powered via this pin, a fuse should be used (rating: 1A Slow).
This pin can also be used to power auxiliary equipment, max 100mA, but note that 
this is not possible when the AXIS 211 is powered by PoE.

1 GND

Terminal connector. Note that the 
pins are numbered 1-4, right to left.

DC-Iris control cable 
(AXIS 211 only).

4 3 2 1
Download from Www.Somanuals.com. All Manuals Search And Download.



 43 AXIS 210/211 - The I/O Terminal Connector
Connect input/output devices to the terminal connector as follows:

1. Loosen the corresponding screw on top of the pin (see above for the correct pin to 
use).

2. Push the cable into the connector and secure it by fastening the screw.

3. Once devices are connected, connect the terminal connector to the camera, 
making sure that all cables are securely fastened.

Schematic Diagram - Terminal Connectors
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Troubleshooting

Checking the Firmware
One of your first actions when troubleshooting a problem should be to check the currently 
installed firmware version. The latest version may contain a correction that fixes your 
particular problem. The current firmware version in your camera can be seen on the page 
Setup > Basic Configuration.

Upgrading the Firmware
Firmware is software that determines the functionality of the camera. When you upgrade 
the firmware with a file from the Axis Web site, your Axis camera will receive the latest 
available functionality. Always read the upgrade instructions and release notes available 
with each new release, before updating the firmware.

Note: Preconfigured and customized settings will be saved when the firmware is upgraded (providing the features 
are available in the new firmware) although this is not guaranteed by Axis Communications. Always read 
the instructions and release notes available with each new release, before upgrading the firmware.

1. Save the firmware file to your computer. The latest version of the firmware is 
available free of charge from the Axis Web site at www.axis.com/techsup

2. Go to Setup > System Options > Maintenance in the camera’s Web pages.

3. In the Upgrade Server section, browse to the desired firmware file on your 
computer. Click Upgrade.

Notes: •After starting the upgrade process, always wait at least 5-10 minutes before restarting the 
camera, even if you suspect the upgrade has failed.

•Your dealer reserves the right to charge for any repair attributable to faulty upgrading by the 
user.
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Emergency Recovery Procedure
If power or the network connection to the camera is lost during the upgrade, the process 
will fail and the unit will become unresponsive. A flashing red Status LED indicates a failed 
upgrade. To recover the unit, follow the steps below. The serial number is found on the 
label attached to the bottom of the camera.

1. Unix/Linux - From the command line, type the following:
arp -s <IP address of camera> <Serial number> temp
ping -s 408 <IP address of camera>

Windows - From a command/DOS prompt, type the following:
arp -s <IP address of camera> <Serial number>
ping -l 408 -t <IP address of camera>

2. If the unit does not reply within a few seconds, restart it and wait for a reply. Press 
CTRL+C to stop Ping.

3. Open a browser and type in the camera’s IP address. In the page that appears, use the 
Browse button to select the upgrade file to use, e.g. axis210.bin or axis211.bin. Then 
click the Load button to restart the upgrade process. 

4. After the upgrade has completed (1-10 minutes), the unit will automatically restart and 
show a steady green on the Power and Status LEDs and flashing green or amber on the 
Network LED. 

5. Referring to the installation guide, reinstall the camera. 

If the emergency recovery procedure does not get the camera up and running again, please 
contact Axis support at www.axis.com/techsup/ 

Axis Support
If you contact Axis support, please help us to help you solve your problems, by providing 
the server report, the log file and a brief description of the problem.

Server Report - go to Setup > System Options > Support Overview. The server report 
contains important information about the server and its software, as well as a list of the 
current parameters.

The Log file is available from Setup > System Options > Logs & Reports. The Log file 
records events in the unit since the last system restart and can be a useful diagnostic tool 
when troubleshooting.
Download from Www.Somanuals.com. All Manuals Search And Download.



 46 AXIS 210/211 - Troubleshooting
Symptoms, Possible Causes and Remedial Actions
Problems setting the IP address

When using ARP/Ping. Try the installation again. The IP address must be set within two minutes after power has 
been applied to the camera. Ensure the Ping length is set to 408. See the Installation 
Guide.

The camera is located on a different 
subnet.

If the IP address intended for the camera and the IP address of your computer are located 
on different subnets, you will not be able to set the IP address. Contact your network 
administrator to obtain an appropriate IP address.

The IP address is being used by another 
device

Disconnect the camera from the network. Run the Ping command. (In a Command/DOS 
window, type ping and the IP address of the unit). 

If you receive: Reply from <IP address>: bytes = 32; time = 10 ms..... - this means that 
the IP address may already be in use by another device on your network. You must obtain 
a new IP address and reinstall the unit. 

If you see: Request timed out - this means that the IP address is available for use with 
your camera. In this case, check all cabling and reinstall the unit.

Possible IP address conflict with 
another device on the same subnet.

The static IP address in the camera is used before the DHCP server sets a a dynamic 
address. This means that if the same default static IP address is also used by another 
device, there may be problems accessing the camera. To avoid this, set the static IP 
address to 0.0.0.0. 

The camera cannot be accessed from a browser
The IP address has been changed by 
DHCP.

1) Move the camera to an isolated network or to one with no DHCP or BOOTP server. Set 
the IP address again, using the AXIS IP Utility (see the Installation Guide) or the ARP/Ping 
commands.
2) Access the unit and disable DHCP in the TCP/IP settings. Return the unit to the main 
network. The unit now has a fixed IP address that will not change.
3) As an alternative to 2), if dynamic IP address via DHCP or BOOTP is required, select the 
required service and then configure IP address change notification from the network set-
tings. Return the unit to the main network. The unit will now have a dynamic IP address, 
but will notify you if the address changes. 

Other networking problems. Test the network cable by connecting it to another network device, then Ping that device 
from your workstation. See the instructions above.

Cannot send notifications, uploads, alarms, etc, to a destination outside the local network
Firewall protection. The camera can be configured to use a SOCKS server to reach networks on the other side 

of a firewall/proxy server.

Camera is accessible locally, but not externally
Firewall protection. Check the Internet firewall with your system administrator.

Default routers required. Check if you need to configure the default router settings.
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Video/Image problems, general
Image too dark or too light. Check the video image settings. See the online help on Video and Image Settings.

Missing images in uploads. This can occur when trying to use a larger image buffer than is actually available. Try 
lowering the frame rate or the upload period.

Slow image update. Configuring, e.g. pre-buffers, motion detection, high-resolution images, high frame rates, 
etc, will reduce the performance of the camera. 

Poor performance. Poor performance may be caused by e.g. heavy network traffic, multiple users accessing 
the unit, low performance clients, use of features such as Motion Detection, Event han-
dling, Image rotation other than 180 degrees.

Image gradually gets darker or lighter. When using the camera in locations lit by fluorescent lighting, check in the advanced 
image settings that the Exposure control is set to Flicker-free. 

Image loses focus often. Disable the DC-Iris (AXIS 211 only) in the settings for Video & Image > Advanced. 
focus the camera, following the instructions on page 11. Then enable the DC-Iris again. 

Problems with the MPEG-4 format
Lower frame rate than expected. Insufficient light will reduce the frame rate. Adjust the low light behavior settings in the 

Video & Image > Advanced > Camera settings.

Check with the administrator that there is enough bandwidth available. Check also the 
settings for bit rate control, in the Video & Image > Advanced > MPEG-4 settings. 
Using an inappropriate video object type can also affect the frame rate. See the online 
help for more information.

Check in the AMC control panel applet (MPEG-4 tab) that video processing is not set to 
Decode only I frames.

Lower the image resolution.

Reduce the number of applications running on the client computer.

No MPEG-4 displayed in the 
client.

Check that the correct network interface is selected in the AMC control panel applet 
(Network tab). 

Check that the relevant MPEG-4 connection methods are enabled in the AMC control 
panel applet (network tab). 

In the AMC control applet, select the MPEG-4 tab and click the button Set to default 
MPEG-4 decoder. 

No multicast MPEG-4 displayed in the 
client.

Check with your network administrator that the multicast addresses used by the 
AXIS 210/211 are valid for your network.

Check with your network administrator if there is a firewall preventing viewing.

Multicast MPEG-4 only accessible by 
local clients. 

Check if your router supports multicasting, or if the router settings between the client 
and the server need to be configured. The TTL (Time To Live) value may need to be 
increased.

Poor rendering of MPEG-4 images Color depth set incorrectly on clients. Set to 16-bit or 32-bit color.

If text overlays are blurred, or if there are other rendering problems, you may need to 
enable Advanced Video Rendering from the MPEG-4 tab in the AMC control panel applet.

Ensure that your graphics card is using the latest device driver. The latest drivers can 
usually be downloaded from the manufacturer's web site. 

Color saturation is different in MPEG-4 
and Motion JPEG.

Modify the settings for your graphics adapter. See the adapter's documentation for more 
information.

Image degeneration. Decrease the GOV length, see the online help for more information.

The Power indicator is not constantly lit
Faulty power supply. Check that you are using an AXIS PS-K power supply.
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For additional assistance, please contact your reseller or see the support pages on the Axis 
Website at www.axis.com/techsup

The Status and Network indicator LEDs are flashing red rapidly
Hardware failure. Contact your Axis dealer.

The Status indicator LED is flashing red and the camera is inaccessible
A firmware upgrade has been inter-
rupted or the firmware has otherwise 
been damaged.

See the Emergency Recovery Procedure above. 

No images displayed on web page
Problem with AMC. 
(Internet Explorer only)

To enable the updating of video images in Microsoft Internet Explorer, set your browser 
to allow ActiveX controls. Also, make sure that AXIS Media Control (AMC) component is 
installed on your workstation. 

Installation of additional ActiveX com-
ponent restricted or prohibited

Configure your camera to use a Java applet for updating the video images under
Live View Config > Layout > Default Viewer for Internet Explorer. See the online help for 
more information.

Poor quality snapshot images
Screen incorrectly configured on your 
workstation

In Display Properties, configure your screen to show at least 65000 colors, i.e. at least 
16-bit. Using only 16 or 256 colors will produce dithering artifacts in the image. 

Browser freezes
Netscape 7.x or Mozilla 1.4 (or later) 
can sometimes freeze on a slow com-
puter.

Lower the image resolution. 

Problems uploading files
Limited space. There is only limited space available for the upload of your own files. Try deleting one or 

more existing files, to free up space.

Overlay not displayed
Total size of image and text overlay 
exceeds maximum size of 640x480.

Using a text overlay affects the amount of space available to the overlay image. The text 
overlay occupies proportionally more and more space the lower the resolution, i.e., 16 
pixels in height at 640x480, 32 pixels at 320x240 and 64 pixels at 160x120. 

Because of this, changing to a lower resolution after configuring an overlay image and a 
text overlay may cause the total overlay size to exceed the maximum size of 640x480, 
and no overlay will be displayed. 

Motion Detection triggers unexpectedly
Changes in luminance. Motion detection is based upon changes in luminance in the image. This means that if 

there are sudden changes in the lighting, motion detection may be istakenly triggered. 
Lower the sensitivity setting to avoid problems with luminance.
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Technical Specifications

Item Specification

Models • AXIS 210
• AXIS 211

Video compression • Motion-JPEG, including single snapshot JPEG images
• MPEG-4 Part2 (ISO/IEC 14496-2), Profiles: ASP and SP

Resolutions • 5 resolutions (640x480, 480x360, 320x240, 240x180, 160x120) available from 
configuration web page

• Total 16 resolutions (including PAL/NTSC formats) available via the HTTP API, see 
www.axis.com/techsup

Frame rate • Motion JPEG: Up to 30 fps in all resolutions
• MPEG-4: Up to 21 fps for 640x480,

up to 30 fps for other resolutions

Video streaming • Simultaneous Motion JPEG and MPEG-4
• Controllable frame rate and total bandwidth
• Constant and variable bit rate (MPEG-4)

Image settings • Compression levels: 11 (Motion JPEG), 23 (MPEG-4)
• Rotation: 90o, 180o, 270o

• Color and black/white
• Overlays: time, date, text, image

Security • Multiple user levels with password protection
• IP address filtering

Users • 20 simultaneous viewers
• Unlimited users using MPEG-4 multicast

Alarm and event management • Events triggered by built-in multi-window motion detection, external input or 
according to set schedule

• Image uploads via FTP, email and HTTP
• Event notification via TCP, email, HTTP and external output
• Up to 1200 KB memory available for pre/post alarm image storage (approx. 20 

seconds 320x240 video at 4 fps)

Video features • Electronic Shutter: 2s - 1/12500s
• Light sensitivity AXIS 210: 3-10 000 Lux
• Light sensitivity AXIS 211: 0.75-500 000 Lux
• Image sensor: 1/4" Sony Wfine progressive scan RGB CCD

Lens (AXIS 210) Standard CS mount lens. F2.0

Lens (AXIS 211) • Varifocal DC-Iris lens with CS Mount. F1.0, 3.0-8.0mm
• Horizontal viewing angle: 27o - 67o

• Focus range: 0.2mm to infinity

Connectors • Ethernet 10BaseT/100BaseTX, RJ-45
• Terminal block: 1 alarm input, 1 output transistor (max 24 V, 0.1 A), alternative 

voltage input

Power • External power adapter PS-K (included): 9V DC, 9W 
• Via terminal connector: 7-20V DC, max 5W
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Processors and memory • CPU: ETRAX-100 LX 32-bit
• Video processing and compression: ARTPEC-2 chip
• RAM memory - 16 MB
• Flash memory - 4 MB

Power over Ethernet 
(AXIS 211 only)

Support for Power over Ethernet according to IEEE802.3af standard, including 
Power classification according to class 0 (max: 12.95W). Connection via RJ-45 
network socket.

Operating conditions • Temperature: +5oC (41oF) to +45oC (113oF)
• Humidity: 20-80% RHG.

System integration support • API for software integration available at www.axis.com includes HTTP API, AXIS 
Media Control SDK

• Event trigger data in video stream
• Embedded scripting
• Embedded operating system: Linux 2.4

Minimum web browsing 
requirements

• Pentium III 500 MHz or higher or equivalent AMD
• 128 MB RAM
• AGP graphics card, DirectDraw, 32 MB video RAM
• Windows: XP, 2000, NT 4.0, ME or 98
• DirectX 9.0 or later
• Internet Explorer 5.x or later

For other operating systems and browsers, see www.axis.com/techsup

Supported protocols HTTP, TCP, RTSP, RTP, UDP, IGMP, RTCP, SMTP, FTP, DHCP, UPnP, ARP, DNS, 
DynDNS, SOCKS

Approvals - EMC • EN55022:1998+A1 (CISPR 22:1997+A1) Class B
• EN55024:1998+A1+A2 
• EN61000-3-2:2000 
• EN61000-3-3:1995+A1
• VCCI:2003, Class B, ITE (CISPR 22:1997+A1:2000, Class B) 
• C-Tick AS/NZS 3548
• FCC part 15, Subpart B, Class B, demonstrated by compliance with 

EN55022:1998 (CISPR 22:1997) Class B
• ICES-003 Class B, demonstrated by compliance with EN 55022:1998, Class B

Approvals - Safety • EN60950
• UL, CSA (PS-K power adapter)

Dimensions - AXIS 210 • HxWxD: 38 x 88 x 146mm (1 1/2 x 3 7/16 x 5 3/4”)
• Weight: 305g (10 3/4 oz) Power adapter excluded.

Dimensions - AXIS 211 • HxWxD: 38 x 95 x 172mm (1 1/2 x 3 3/4 x 6 15/16”)
• Weight: 345g (12 3/16 oz) Power adapter excluded

Complimentary Software • AXIS Media Control (AMC) - ActiveX component software required for Microsoft 
Internet Explorer, installed automatically on first use.

• Optional: AXIS IP Utility - Windows installation. 

MPEG-4 licensing Licenses for one MPEG-4 encoder and one MPEG-4 decoder included. Additional 
licenses available from Axis dealers. 

Item Specification
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General performance considerations
When setting up your system, it is important to consider how various settings and 
situations will affect performance. Some factors affect the amount of bandwidth (the bit 
rate) required, others can affect the frame rate, and some will affect both. If the load on the 
CPU reaches its maximum, this will also affect the frame rate.

The following factors are among the most important to consider:

• High image resolutions and/or lower compression levels result in larger images. 
Bandwidth affected. 

• Access by large numbers of Motion JPEG and/or unicast MPEG-4 clients. Band-
width affected.

• Simultaneous viewing of different streams (resolution, compression, etc.) by dif-
ferent clients. Frame rate and bandwidth affected.

• Accessing both Motion JPEG and MPEG-4 video streams simultaneously. Frame 
rate and bandwidth affected.

• Heavy usage of event settings affects the camera’s CPU load. Frame rate affected.
• Enabled motion detection. Frame rate and bandwidth affected.
• Heavy network utilization due to poor infrastructure. Bandwidth affected
• Viewing on poorly performing client PC’s lowers perceived performance. Frame 

rate affected.

Optimizing your system

To see the bandwidth and frame rate currenty required by the video stream, the AXIS 
210/211 provides a tool that can be used to display these values directly in the video 
image.

To do this, special format strings are added as part 
of a text overlay. Simply add #r (average frame 
rate in fps) and/or #b (average bandwidth in kbps) 
to the overlay. 

For detailed instructions, please see the online help 
for Video & Image > Overlay Settings, and the 
help for File Naming & Date/Time Formats.

Important!
•The figures displayed here are the values as delivered by the camera. If other restrictions are 

currently in force, (e.g. bandwidth limitation) these values might not correspond to those actu-
ally received by the client.

•For Motion JPEG, these values will only be accurate as long as no frame rate limit has been 
specified.
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Frame rates - Motion JPEG and MPEG-4
The following table shows typical frame rates in frames/second (fps) for Motion JPEG and 
MPEG-4 video streams from the AXIS 210/211.

Note that these values are guidelines only - actual values may vary. 

Motion JPEG settings:

• Viewing in AMC
• Compression level = 30%

MPEG-4 settings:

• Viewing in AMC
• Compression level = 30%
• Video Object Type = Advanced Simple
• GOV length = 8
• GOV structure = IP*

*Note that setting the GOV structure to use “I-frames only” will increase the frame rate.

Bandwidth
As there are many factors that affect bandwidth, it is very difficult to predict the required 
amounts. The settings that affect bandwidth are:

• the image resolution
• the image compression
• the frame rate
• the MPEG-4 object type
• the MPEG-4 GOV structure
• the maximum exposure time.

There are also factors in the monitored scene that will affect the bandwidth. These are: 

• the amount of motion
• the image’s complexity
• the lighting conditions.

For MPEG-4, if there is only limited bandwidth available, and if this is more important 
than the image quality, using a constant bit rate (CBR) is recommended. Use a variable bit 
rate (VBR) if the image quality needs to be maintained at a higher level. If supported on the 
network, consider also using MPEG-4 multicasting, as the bandwidth consumption will be 
much lower.

Frame rates 
Motion JPEG MPEG-4

640x480 30 21
480x360 30 30
320x240 30 30
160x120 30 30
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ActiveX - A control (or set of rules) used by a browser. 
ActiveX controls are often downloaded and installed 
automatically as required.

AMC - AXIS Media Control. The control required for 
viewing video images in Internet Explorer. Installs 
automatically on first use.

API - Application Programming Interface. The Axis API can 
be used for integrating Axis products into other 
applications.

ARP - Address Resolution Protocol. Used to associate an IP 
address to a hardware MAC address. A request is broadcast 
on the local network to find out what the MAC address is 
for the IP address.

ARTPEC - Axis Real Time Picture Encoder - used for video 
image compression.

CCD - Charge Coupled Device. CCD is one of the two main 
types of image sensors used in digital cameras. When a 
picture is taken, the CCD is struck by light coming through 
the camera’s lens. Each of the thousands or millions of tiny 
pixels that make up the CCD convert this light into 
electrons. 

CGI - Common Gateway Interface. A set of rules (or a 
program) that allows a Web Server to communicate with 
other programs.

Client/Server - Describes the network relationship between 
two computer programs in which one, the client, makes a 
service request from another - the server.

DC-Iris - This special type of iris is electrically controlled 
by the Axis camera, to automatically regulate the amount of 
light allowed to enter.

DNS - The Domain Name System (DNS) locates and 
translates Internet domain names into IP (Internet Protocol) 
addresses.

Ethernet - A widely used networking standard.

ETRAX - Axis' own microprocessor.

Firewall - A virtual barrier between a LAN (Local Area 
Network) and other networks, e.g. the Internet.

FTP - File Transfer Protocol. Used for the simple transfer of 
files to and from an FTP-server.

HAD - Hole Accumulation Diode. A HAD CCD design allows 
for more light to reach the imager, which reduces video 
noise to improve signal-to-noise ratio by up to 6dB (2x 
better than a standard CCD imager). Particularly effective 
when shooting in dark situations.

HTML - Hypertext Mark-up Language. Used widely for 
authoring documents viewed in web browsers.

HTTP - Hypertext Transfer Protocol. The set of rules for 

exchanging files (text, images, sound, video, and other files) 
on the World Wide Web.

Intranet - A private network limited to an organization or 
corporation. Usually closed to external traffic.

IP - Internet-Protocol. See TCP/IP.

IP address - A unique number used by a network device, to 
allow it to be identified and found on the network. The 
32-bit IP address is made up of four groups (or quads) of 
decimal digits separated by periods. An example of an IP 
address is: 192.168.0.1

ISMA - Internet Streaming Media Alliance

JPEG - A standard image format, used widely for 
photographs. Also known as JPG.

LAN - A local area network (LAN) is a group of computers 
and associated devices that typically share common 
resources within a limited geographical area.

Linux - A popular operating system, which is “open source” 
and practically free of charge.

Lux - A standard unit for the measurement of light, where 1 
Lux equals the light emitted from a single candle at a 
distance of one meter.

Mbit/s - Megabits per second. A unit for measuring speeds 
in networks. A LAN might run at 10 or 100 Mbit/s.

MPEG-4 - A video compression standard that makes good 
use of bandwidth, and which can provide DVD-quality 
video streams at less than 1 Mbit/s.

Multicast - A bandwidth-conserving technology that 
reduces bandwidth usage by simultaneously delivering a 
single stream of information to multiple network recipients. 

NTSC - National Television Standards Committee. NTSC is 
the standard format used for televisions in most of North 
and Central America, and Japan. 

NWAY - A network protocol that automatically negotiates 
the highest possible common transmission speed between 
two devices.

PAL - Phase Altering Line. PAL is the standard format used 
for televisions in most of the world (other than the US, 
Canada, and Japan).

Ping - A small utility used for sending data packets to 
network resources to check that they are working and that 
the network is intact.

Pre/post alarm image - The images from immediately 
before and after an alarm.

Protocol - A special set of rules governing how two entities 
will communicate. Protocols are found at many levels of 
communication, and there are hardware protocols and 
software protocols.

Router - A device that determines the next network point to 
which a packet should be forwarded on its way to its final 
destination. A router is often included as part of a network 

Glossary of Terms
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switch (see below).

RTP- Real-Time Transfer Protocol. A transfer protocol 
designed for delivery of live contents, e.g. MPEG-4.

Simplex - In simplex operation, a network cable or 
communications channel can only send information in one 
direction. 

SMTP - A common e-mail protocol.

Subnet Mask - An IP address consists of two components: 
the network address and the host address. “Subnetting’ 
enables a network administrator to further divide the host 
part of the address into two or more subnets. The subnet 
mask identifies the subnet to which an IP address belongs. 

Switch - Whilst a simple hub transmits all data to all 
devices connected to it, a switch only transmits the data to 
the device it is specifically intended for. 

TCP/IP - Transmission Control Protocol/Internet Protocol. A 
suite of network protocols that determine how data is 
transmitted. TCP/IP is used on many networks, including the 
Internet. TCP keeps track of the individual packets of 
information and IP contains the rules for how the packets 
are actually sent and received. 

Unicast - Communication between a single sender and a 
single receiver over a network. A new connection is 
established for each new user. 

UPnP™ - An “address" on the network. UPnP is an 
architecture for peer-to-peer network connectivity of 
intelligent appliances, wireless devices, and PCs.

URL - Uniform Resource Locator. An “address" on the 
network.

Varifocal - A varifocal lens provides a wide range of focal 
lengths, as opposed to a lens with a fixed focal length, 
which only provides one.

WAN - Wide-Area-Network. Similar to a LAN, but on a 
larger geographical scale.

Web server - A program on a computer (server) providing 
the resources (e.g. web pages) requested by the user (client).
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